EDRMS Content Manager
Search Guide

VERSION 1.0
# Contents

About Searching with EDRMS Content Manager ................................................................. 1

Search Methods .................................................................................................................. 1

  Prefix Searches ............................................................................................................... 1

  Quick Search Using the Search Pane .............................................................................. 1

Using the Search for Records or Locations Popup .............................................................. 2

  Boolean Searches ......................................................................................................... 3

  Boolean Search Examples .......................................................................................... 5

  Multi-field Searches .................................................................................................... 9

Options Tab ....................................................................................................................... 10

Sort Tab ............................................................................................................................ 11

Results Tab ....................................................................................................................... 12

Searching for Classifications ......................................................................................... 12

Advanced Searching ....................................................................................................... 14

  String Based Searches ............................................................................................... 14

  Document Content Searches ....................................................................................... 16

Working with Search Results ............................................................................................ 18

  Changing the Sort Order of Search Results ................................................................. 18

Refining a Search .............................................................................................................. 18

Customizing the List and View Panes .............................................................................. 18

Tagging Items ................................................................................................................... 20

Search Right Click Options .............................................................................................. 21

Folders, Documents and Boxes ....................................................................................... 22

  Electronic Folders ......................................................................................................... 22

  Electronic Documents .................................................................................................. 22

  Physical Folders ........................................................................................................... 22

  Physical Documents .................................................................................................... 22

  Boxes ............................................................................................................................. 22

Saving a Search .................................................................................................................. 22

  Moving Between Open Searches .................................................................................. 23

  Using Saved Searches ................................................................................................. 23

  Speeding up a Search ................................................................................................... 24
About Searching with EDRMS Content Manager

You can search for EDRMS Content Manager items (Records, Locations, Classifications, Record Types, etc.) using practically all the information about them in EDRMS Content Manager. There are search methods that are quick and simple, and others that may take a little longer to set up, but enable you to combine criteria in a more sophisticated manner to get a more detailed result.

Search Methods

Prefix Searches

Prefix searches in EDRMS Content Manager allow you to enter the start of an item title in any list and EDRMS Content Manager will jump to the first occurrence. For example, in a list of Locations, enter C to jump to the first Location on the list beginning with C.

Prefix search operates with the default column sort order, using the first column by default. When you change the column order or sort by any other column, the prefix search will only retrieve data that has already been displayed. When you change the column order and then sort by the first column, the prefix search function will operate correctly.

Quick Search Using the Search Pane

The simplest way to search in EDRMS Content Manager is using the Search Pane.

The Search Pane is located just below the Ribbon on the main EDRMS Content Manager window, regardless of which tab you have selected.

If the Search Pane is not displayed, check the Search box on the View tab.
To perform a simple search from the Search Pane:

1. From the **Search for** dropdown, select the item you are searching for – Records, Locations, Classifications, Record Types, etc.
2. From the **Search by** dropdown, select how you would like to perform the search.
3. For example, if you are searching for records, you can search by **creator** to find all records created by a specific user. Or you can search by a specific record number – you must provide the complete record number for simple searches.
4. In the **Matching criteria** field, enter the data you want to search for. For example, if you are searching for records created by a specific user, enter the user’s name.
5. Click **Run the Search**.

Your search results will be displayed in the View Pane.

**Using the Search for Records or Locations Popup**

Another way of searching involves the **Search for** popup, which gives you much more flexibility and power in your search.

**Note:** This process is not used to search for Classifications. See [Searching for Classifications](#) for details on how to perform a more detailed search.

To use the **Search for** popup:

1. From the Search tab, select **Records** or **Locations** and then **Find Records** or **Find Locations**.
2. The **Search for** popup layout and fields will depend on the type of item – Record or Location – you are looking for, and the search editor you are using.
3. Search editors are:
   - Boolean (default)
   - Multi-field
   - String (see Advanced Search below)

You can change the search editor you are using with the **Editor** dropdown at the bottom of the **Search for** popup.

4. Follow one of the searches:
Boolean Searches

Boolean searches allow users to combine keywords with the operators AND, OR and NOT to produce more relevant results. Brackets (...) are also used to show the order in which search criteria are to be addressed.

To perform a Boolean search:

1. On the Search for popup, select Boolean from the Editor dropdown.
2. Select a method to Search by from the dropdown (displays recently used search methods), or click the blue folder to open the Search Methods popup and select one. The list of available search methods changes dynamically.
3. Complete further search fields as required – these will depend on the Search by method selected. For example, if searching by Record Number, you will need to select a search operator to use for the search – for example Matching – and a string value to search for:
4. If more search options are required:
   a. Click **New** above the current selection box.
   b. Select another method from the **Search by** dropdown, or select a new search option from the **More search options** dropdown.
   c. Enter the search criteria for the new search options. For example, a pre-set date range.
   d. Select **AND** if you want this search criterion to be added to the previous one – the search will find records that meet **BOTH** criteria.
   e. Select **OR** if you want an **EITHER/OR** search – the search will find records that meet either one of the criteria, or both of them.
   f. Select **NOT** to find exclude records from the specified search criterion.

5. Click **OK**. EDRMS Content Manager displays the results in the List Pane.

**Boolean Operators:**
- **AND**: combines multiple sets of search criteria
- **OR**: performs a search to include records that meet either one or the other criteria
- **NOT**: refines a search to include only records that meet the **previous** but not the **current** set of search methods. It is used in conjunction with the **AND** operator.
- **Brackets (...)**: groups sets of search methods by putting them in brackets
Bracketed methods will be processed first, and then any preceding and following methods will be processed. This button will remain greyed until two or more lines of selection methods are tagged. This function is called Brackets in the right click menu.

- **New**: adds a new set of search methods at the bottom of the list
- **Insert**: inserts a new set of search methods just above the currently selected set
- **Delete**: deletes the currently selected set of search methods
- **Reset**: deletes all the search methods so you can start a fresh search

**Boolean Search Examples**

**Single Search Criterion**

- Search for records with the Record Number that begin with the string D54833.
AND Operator

- Search for records with the Record Number that begin with the string D54833, AND that were registered between the dates 2018-08-28 and 2018-10-03.
OR Operator

- Search for records either with the Record Number that begin with the string D54833, OR that were registered between the dates 2018-08-28 and 2018-10-03.
NOT Operator

- Search for records with the Record Number that begin with the string **D54833 AND** that were registered between the dates **2018-08-28 and 2018-10-03**, but **NOT** those with the owner **CITZ CIRMO Divisional Operations**.
Brackets (…)

- First, search for records with the Record Number that begin with the string D54833 AND that were registered between the dates 2018-08-27 and 2018-10-03.
- In those search results, search for records with the owner CITZ CIRMO Divisional Operations.

Multi-field Searches

Multi-field searches combine a number of standard fields, allowing you to search for EDRMS Content Manager Records and Locations. The fields in the popup and the tabs for further search criteria will differ depending on the item you are searching for. Your search will return items that match all the criteria you have entered, like in a Boolean AND search.

Note: While you can perform multi-field searches for Classifications, the process is different from that for Records or Locations. Refer to Searching for Classifications.

To perform a multi-field search:

1. On the Search for popup, select Multi-field from the Editor dropdown.
2. On the Search for Locations popup:
   a. On the Name tab:
EDRMS Content Manager: Search Guide

i. In the Locations with names matching field, enter a search string related to the Location name you are searching for.

ii. Select Combine with one or more of the following fields and fill out the desired fields if you want to add further search criteria.

b. On the Filter tab, you can deselect Location filters to further refine your search. Note that of the Location Type filters, Organization is the only filter in use.

3. Complete the Options, Sort and Results tabs as required.

4. Click OK.

Options Tab

The Options tab on the Search for popup allows you to select specific options for your search results:

Search for Records
- **Assignee section**: not used
- **Search optimizer**: the following options may improve the performance of a search for very large volumes:
EDRMS Content Manager: Search Guide

- **Use extended Content Index optimization**: improves the performance of searches based on content indexes
- **Allow direct Content Index queries**: improves the performance of searches based on content indexes
- **Convert OR operators to form a SQL UNION**: make sure this box is unchecked

**When searching for records using the default method: set your search preference:**

- **Include matching record numbers**: on by default, this will include matching record numbers in results
- **Include matches in record titles**: on by default, this will include matching record titles in results
- **Include matches in record notes**: check to broaden your search to include record notes
- **Include matches in record content**: check to broaden your search to include electronic record content
- **Get Default**: check to replace the settings on this tab with the default settings.
- **Save as default options**: we recommend that you check this box after making your option selections so that they remain in place for future searches.

**Search for Locations**

- **Include locations that match because of a ‘use address of’ reference**: not used
- **Include locations that match because of a ‘use profile of’ reference**: not used
- **Get Default**: check this box to replace the settings on this tab with the default settings.
- **Save as default options**: not used

**Sort Tab**

Use the Sort tab to set up sort options prior to running the search. To use the Sort tab:

1. Select sort options from the dropdowns in fields 1, 2 and 3 to specify how you want to sort the search results. EDRMS Content Manager will sort the list by the first field, then the second, then the third. The options available in the dropdowns depend on what you are searching, and the search editor you are using.

2. You can provide one, two, or three sort options, or none at all. Providing no sort options is the default; results will be displayed as the search inquiry finds them in the dataset which will give you faster searching.

3. By default, EDRMS Content Manager sorts the results list in ascending order of its sort field, with the lowest numerical, date or alphabetical value at the top of the list and the lowest at the bottom. Check the **Descending** box to reverse this order.

4. Check the **Use alphabetical order for object sorting** box to sort a result alphabetically.

5. Check the **Save as Default Sort Fields** to save the selected sort options as the default for all future sorting.
6. Click **OK**.

**Results Tab**

Use the **Results** tab to select the columns that EDRMS Content Manager should use when displaying search results. You can save your searches, which also saves the default column setup.

To add or remove the columns that EDRMS Content Manager should use when displaying search results:

1. Select an item from the **Available Columns** list and click **Add**. The Displayed Columns window displays the columns that you have added to your List Pane. You can click **Up** and **Down** to change the order of the columns.

2. To remove a column, select it from the **Displayed Columns** list and click **Remove**.

3. Click **OK**.

While EDRMS Content Manager does not keep this column order for subsequent searches, you can save the search, which also saves the columns you selected.

By default, **Use the default column setup for this type of EDRMS Content Manager object** is selected by default. Clear this checkbox if you want to customize columns when displaying search results.

**Searching for Classifications**

You can use the **Quick Search** to search for Classifications, but performing a more detailed search is a little different from searching for Records or Locations. Rather than selecting **Find** from the Search tab, you must first display a list of Classifications.

1. Click **Classifications** on the Search tab, or select **Classifications** from the **Classifications** dropdown on the Manage tab. A list of your top 25 Classifications will be displayed.

2. Right click anywhere in the window and select **Search** and then **Refine Search**, or press **F7**.
3. The **Search for Classifications** popup will be displayed, which functions like **Search for Records** or **Search for Locations**, but has fewer tabs. Select one of the search editors and follow the process for the type of search:

- **Boolean Searches**
- **Multi-field Searches**
- **String-based Searches**
- **Document Content Searches**
Advanced Searching

String Based Searches

The string-based search editor allows you to use search strings to take full advantage of EDRMS Content Manager's advanced search capabilities. You can combine large numbers of criteria, using advanced filter and sort options. This allows you to create searches that are not possible using any other method; for example, you want to find all the documents that are contained in a box, but when using other methods you can only find documents contained in a folder. String search allows you to search for documents in one container that is in another container. Or, you can search for any inactive person who has been applied to any access control on any record. You wouldn't need to know their name, just that they are a user and not active. This is not something you can do with a Boolean search.

String search is for very granular searching only, and would only ever be used as a last resort, and by someone who can understand how the tables might work and link together.

To perform a string-based search:
1. From the Search tab, select Records or Locations and then Find Records or Find Locations.
2. On the Search for popup, select String from the Editor dropdown.
3. On the **Search** tab, use the **Enter search string** field to build your search.

You can enter your search clauses manually or use blue folder to select them and string them together.

![Search for Records](image)

a. Click the blue folder to display the **Search Methods** popup.

![Search Methods](image)

b. Click the + beside each group of methods to expand the list.
c. Select a search method: details about it will be displayed below the window.

d. Click OK.

4. Filter search results using the Filter tab:

For every search editor there are two filter options. The available filters depend on what you are searching for. When you click Editor and select Filters, you will be able to select one of two options.

- The Multi-field filter is the default for Boolean and Multi-field search editors.
- The String filter is the default for the String search editor.

**Document Content Searches**

Document content searches search the text of electronic documents attached to records.

**To Search for a Term Using Document Content:**

1. From the Search tab, select Records and then Find Records.
2. At the end of the Search By field, click the blue folder.
3. On the Search Methods popup, click the + beside Text Search and then select Document Content.
4. Click OK.

5. In the **Enter the search criteria for content search** field, enter the text to search for. When searching for content phrases, exclude text symbols and other special characters such as the forward slash (/) from your search criteria. When searching for a specific phrase, enclose it in quotation marks, for example “information workers”.

![Search Method](image-url)
6. Click OK.

7. EDRMS Content Manager returns a list of records matching the search criteria.

8. To refine your search, press F7. You can filter and sort your search results.

**Working with Search Results**

**Changing the Sort Order of Search Results**

In the search results window, EDRMS Content Manager will automatically sort the columns in alphanumeric order according to the column selected. The sort can be in descending or ascending order. Each time you click, EDRMS Content Manager will reverse the order. A small triangle will appear in the header of the column to indicate the sort order.

**Refining a Search**

When your search results list is too long, you can refine the results without having to re-enter your search criteria.

1. To refine your search in the search results list:
   - Press F7 or
   - Right click in the List Pane and select Search and then Refine Search or
   - Click the Refine Search icon in the Current Search area.

2. On the Search for Records popup, refine your results by:
   - Adding or deleting search criteria on the Search tab.
   - Setting filters on the Filter tab.
   - Sort by items on the Sort tab.

3. Click OK to filter the search results.

**Customizing the List and View Panes**

The Search Results window is divided into two parts: the List Pane on the top and the View Pane on the bottom. The List Pane lists your search results, favourite records, or whatever you have populated in the window. When you select an item in the list, details about it are shown in the View Pane.

Both panes are customizable.
To customize the List Pane:

1. Right click in the List Pane header. A number of options are available:

   - **Sort Ascending**: sorts the list in ascending order
   - **Sort Descending**: sorts the list in descending order
To add or remove columns:

1. Select an item from the Available Columns list.
2. Click Add. The Displayed Columns window shows the columns that you have added to your List Pane. You can click Up and Down to change the order of the columns.
3. To remove a column, select it from the Displayed Columns list and click Remove.
4. Click OK.

To customize the View Pane:

1. Right click anywhere in the View Pane.
2. Select Customize. The Record View Pane popup is displayed.
1. On the Record View Pane popup, select an item from the Available Fields list.
2. Click Add. The Displayed Fields window shows the columns that you have added to your List Pane. You can click Up and Down to change the order of the fields.
3. To remove a field, select it from the Displayed Fields list and click Remove.
4. Click OK.

Tagging Items

Tagging allows you to select multiple items and apply the same function to them. For example, you can tag a set of records and change their Location, or right click and Check Out the tagged records.

Tagged items have a check mark in the tag column. A tag changes the tag status of the currently selected item which means you can perform tasks only on those items on the screen that are tagged.

1. To tag an item, click in the Tag column beside it.
2. To tag all items in a list:
a. Right click in the List Pane and select Tag All, or
b. Select Tag All in the Tag area of the Search tab.

3. To untag all items in a list:
   a. Right click in the List Pane and select Untag All, or
   b. Select Untag All in the Tag area of the Search tab.

4. Clicking Invert All Tags swaps tagged and untagged items in a list.

**Search Right Click Options**

When you have performed a search, right clicking in the View Pane of the search results list and selecting Search offers the following options:

- **Refine Search**: refines your search results by adding further criteria or sorting and filtering options.
- **Open Saved Search**: displays your list of saved searches.
- **Trays**: display the content of your trays.
- **Refresh Search**: runs the search again.
- **Count**: counts the records displayed in the current search results list.
- **Save Search As**: saves your search criteria with a different name and/or criteria. For example, if you have opened a saved search and want to change the details and save it as a different saved search.
**Folders, Documents and Boxes**

Unless you have filtered your search results for a specific record type, EDRMS Content Manager displays electronic and physical folders, documents and boxes in search results windows.

**Electronic Folders**

Electronic Folders (e-folders) are represented by a yellow folder icon in the search results window and can contain physical folders (blue folder icon), and electronic documents. A physical folder may be related to a corresponding e-folder. An e-folder may exist on its own, as may a p-folder.

A p-folder and its contents are contained in an e-folder when the contents form part of a collection of records that are related (that is to say, the records all belong to the same business file).

**Electronic Documents**

Electronic documents are represented by the application icon in which they were created. For example, a Word document will have the Word icon next to the record. Electronic documents can be checked out of EDRMS Content Manager for editing purposes and then checked back in.

**Physical Folders**

P-folders are represented by a light blue folder icon in the search results window. Only the p-folder itself will generally be shown in EDRMS Content Manager. The hardcopy documents in the folder will not be individually displayed.

**Physical Documents**

Physical documents may take any form of media (sound, text, graphic, audio-visual).

**Boxes**

There are two kinds of boxes to hold p-folders. Boxes with blue-coloured lids hold p-folders that have been transferred to off-site storage. Boxes with yellowish-red coloured lids contain p-folders that have been destroyed onsite at the ministry.

Electronic documents within e-folders in offsite storage blue boxes are still available to Users. Electronic documents within e-folders in destroyed yellowish-red boxes are no longer available to Users.

**Saving a Search**

You can save a Record or Location search, which includes the search parameters, filters and other options, and the column configuration for the search results. These searches can be accessed by you or others at a later date.

You can access Record searches by clicking the Search tab and selecting Saved Record Searches. You can access Location searches by clicking the Search tab and selecting Saved Location Searches. EDRMS Content Manager allows you to move back and forward between currently open searches.

To save a search:

1. Run a record or location search.
2. Right-click in the search result window, select **Search** and then **Save Search As**.

3. The **New Saved Search** popup is displayed. Enter details for the saved search:
   - **Name**: enter a name for the saved search (maximum of 50 characters). Use a name that will be easy to find the next time you want to use the search.
   - **Description**: the description of the search methods you used is provided by EDRMS Content Manager. You can edit this description.
   - **Icon**: if desired, select an icon for the search
   - **Owner**: select a location who should have access to this search:
     - **Person**: only the owner has access to the saved search, it is private
     - **Blank**: everyone has access to the saved search, it is public
     - **Group**: only members of the group have access to the search
   - **Within Search Group**: enter the search group you want to save the search in:
     - Type a new group name and EDRMS Content Manager will ask you whether you want to create a new search group.
     - Search groups help you organise your saved searches, but are not saved searches themselves.

4. To set sort and filter options, click **Edit Query** and change them on the Sort, Filter and Record Types tabs on the Search for Records popup. Click **OK**.

5. From the **New Saved Search** popup, select the Access Controls tab to set Access Controls for the saved search, such as who can use the search, modify it, modify access and delete it. It is **recommended** that you restrict all access other than **Can Use** so that other users will not be able to change your saved searches.

6. Click **OK**. If a saved search with the specified name exists already, a message will ask you whether you want to overwrite the existing search.

### Moving Between Open Searches

Based on the active window and search parameters, EDRMS Content Manager allows you to move back and forward between currently open searches.

To do this:

1. Make sure you have the Tab Bar turned on in EDRMS Content Manager. To do this, select the **View tab** and then **Tab Bar**. You can choose to have the Tab Bar at the top of the List and View Panes, or at the Bottom.

2. Once the Tab Bar is enabled, all open windows will be displayed along it. Every time you open a saved search, it will be shown in the Tab Bar along with the record parameters you set. To move between open searches, click on the tab you want.

### Using Saved Searches

To access your saved Record or Location searches:
1. From the Search tab, select **Records** and then **Saved Record Searches**, or
2. From the Search tab, select **Locations** and then **Saved Location Searches**.
3. A list of all your saved searches will be displayed.
4. Click on a search to open it and display the results.

**Speeding up a Search**

Searches take much longer if your search screen includes columns that require calculation, such as **Date Due for Destruction**. Removing these columns before searching will speed up your searches. You can re-add them when your search is completed, if required.

To add or remove columns from the List Pane:

1. From the View menu, select **Format Columns**. The **Columns Preferences** popup is displayed.

   **OR**

2. Right click on the column header and select **Format Columns**.

3. On the **Column Preferences** popup, select columns from the Displayed Columns list and click **Remove**.

4. To add the columns back, select it from the Available Columns list and click **Add**.